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Welcome

 

Welcome to Win School

 

®

 

 Getting Started Guide.

Win School is a complete student information system for schools. Designed by 
Chancery Software, Win School has both power and flexibility. Using 
Win School, large and small schools can perform their administrative and data-
entry tasks quickly and efficiently throughout the school year. 

 

Why Read This Guide

 

The purpose of this guide is to give first-time users—whether principals, vice-
principals, secretaries, counselors, or teachers—the knowledge to use this 
software with confidence. 

New software can be intimating when first starting out. This guide describes how 
Win School works and suggests ways to implement the software. It also describes 
basic operating conventions that all staff will need to know to operate the software 
successfully. 

Win School is a system with great flexibility. Schools have the choice of many 
options to choose from when getting started. Knowing how Win School works 
helps schools to:

 

• customize the software to their needs

• determine which staff should use the software and when they should use it

• eliminate problems before they happen, or, when problems do occur, know 
where to look to find solutions quickly

 

Who Should Read This Guide 

 

Getting Started with Win School lays the groundwork for using the software and 
understanding what’s written in all other Win School guides. 

All staff using Win School for the first time should read this guide.

 

That includes:

 

• principals

• vice-principals

• secretaries

• teachers

• clerks

• counselors
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• administrators

• technical coordinators

 

Using Win School Guides 

 

Win School documentation provides step-by-step instructions for tasks staff 
perform. In addition to the Getting Started guide, there are eight other Win School 
guides.

 

They are:

 

• System Administrator Guide

• School Setup Guide

• Details Guide

• Scheduler Guide

• Attendance Guide

• Report Manager Guide

• Report Cards Guide

• Marks Guide

• Universal Access and District Extract

• Scanning and ASCII Transfer

 

The next two sections describe the contents of the Win School guides.

 

What’s in This Guide

 

The following table describes what’s in each chapter of the Getting Started guide. 

 

In the Getting Started 
Guide

This chapter Describes

 

No computing experience 
is required before reading 
these chapters.

The Big Picture how Win School works and the 
software components it is made 
up of

Using Win School 
over the School Year

the tasks, software, and staff 
involved in using Win School 
over one school year

Implementation 
Strategies

3 strategies for a successful 
implementation

A basic understanding of 
your computer and the 
Microsoft® Windows™ 
environment is required 
before reading these 
chapters

 

.

 

Reviewing Basics operating features and window 
conventions specific to Win 
School

Using Query how to use Query, a view-only 
Win School module used by most 
staff

Glossary terms specific to Win School
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Other Win School Guides

 

Staff can find detailed information about how to do specific tasks in the following 
guides:

 

Getting Help

 

In addition to this guide, you can consult the following sources:

 

• online help

• update notes

• other Win School reference guides

• Chancery’s Technical Support staff

 

Online Help 

 

Win School uses Microsoft

 

®

 

 

 

Windows

 

™

 

 Help which has a variety of features to 
make information easy to find. Use online help for quick reminders on what a 
feature is and how to use it.

 

To find out how to use Windows Help

 

• From the Help menu, choose How To Use Help.

 

To do this Refer to this Win School Guide

 

install and set up Win School System Administrator Guide
set up for the first time School Setup Guide
enter course, teacher, and student 
information

Details Guide

build school and student schedules Scheduler Guide

Before reading this guide, you should be 
familiar with the Getting Started, School 
Setup, and Details user guides.

enter and track attendance Attendance Guide
generate report cards Report Cards Guide
track student marks Marks Guide
view student, teacher, class, 
scheduling, and student marks 
information

Getting Started Guide

create custom reports Report Manager Guide

Before reading this guide, you should be 
familiar with all other Win School guides.

generate state or provincial reports State or Provincial Reports Guide
scan data Scanning and ASCII Transfer Guide
transfer ASCII files Scanning and ASCII Transfer Guide
prepare for next year System Administrator Guide
use the Win School Server System Administrator Guide
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To access the Contents for the Win School Help

 

• From the Help menu, choose Contents.

 

OR

 

If Help is open, click the Contents button.

 

To access context-sensitive help for the dialog or window you have open on 
your screen (context-sensitive help is not available in all modules):

 

• From the Help Menu choose, Help on Active Window.

 

OR

 

Press F1.

 

Finding Information

 

If you click any underlined text, the help will open a topic describing or relating 
to that text.

To find the most up-to-date information on new features or changes, open the 
What’s New topic, or visit Chancery’s support web site at 
http://support.chancery.com. 

To open the search window where you can type keywords to help you locate a 
topic, click Search.

To open a list of terms pertaining to Win School or the module, click Glossary.

To print the topic currently open on your screen, from the File menu, choose Print 
Topic, and click OK in the dialog that appears.

 

Update Notes 

 

As the software evolves, Chancery periodically releases upgraded versions of 
Win School. These releases come with update and installation notes that give 
useful information on new features, fixes, and changes to the software.

 

Other Win School Reference Guides 

 

Use the individual Win School User Guides

 

 

 

for detailed information about 
specific procedures, such as how to enter attendance or generate report cards. 

Use the Win School System Administrator Guide for detailed information how to 
configure your system, and install and set up the software.
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Getting Technical Support 

 

Chancery’s support programs are available by subscription and include the below 
services

For more information on Technical Support Programs, call Chancery Customer 
Service at 1-800-999-9931 extension 130.

 

Providing Feedback

 

To improve the quality of your documentation, we would like your comments 
regarding this guide. Email comments to Chancery’s User Education department 
at user_docs@chancery.com.

 

About Chancery Software 

 

Chancery Software, a leader since 1985 in information management systems for 
schools and school districts, produces a wide range of products for both 
Macintosh

 

®

 

 and Windows environments, including student, library, and district 
management systems.

Chancery products are used by over 8,500 schools in 11 countries, worldwide.

Chancery’s head office is located in Vancouver, Canada. 

 

Technical Support solves problems and answers questions when software 
doesn’t produce the expected results.

Monday to Friday, 5 am to 5 pm Pacific Time
phone: 1-800-688-9939
fax: 1-800-346-0643
email: techsupp@chancery.com
website: http://support.chancery.com

Web support Chancery’s website includes a searchable knowledge base 
with frequently asked questions, tips, and troubleshooting, as 
well as support forums for users to share experience and 
knowledge. Web tutorials are available on an annual 
subscription basis.

Software updates releases of new versions with improved functions and 
software fixes. Updates are provided free of charge for 3 
months from your date of purchase and are included in the 
subscription to Chancery Support Programs.
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The Big Picture

 

Understanding how Win School works makes getting started much easier. 

This chapter describes the big picture—the components of Win School and how 
they are related. 

 

What Is Win School 

 

Win School is a powerful student information system for schools. 

 

Using Win School, staff can do these tasks:

 

• enroll and withdraw students

• track and report student conduct

• enter attendance and print reports

• schedule school and students

• record and report academic progress

• print transcripts

• generate reports

 

How Win School Works

 

The Win School student information system is made up of 2 main components: 
your Win School modules and your school data.

 

Difference between Modules and Data

 

Modules and data are two different things:

 

 

 

• Modules

 

 

 

are software programs, received from Chancery, that staff use to 
record school data and perform tasks, such as creating schedules or 
generating term reports.

Win School = modules + data 
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Here’s a list of all Win School modules, plus two special software 
applications

 

*

 

:

Depending on what features are required, your school may or may not have 
purchased all Win School modules.

 

• Data is factual information, such as student names or courses numbers, that 
staff enter using the modules. 

Modules are shipped to your school with no data. When staff start a module 
for the first time, no classes, courses, teachers, or students are displayed on 
your screen, unless schools opt to install Win School’s sample data.

Schools enter data either manually or by importing data from another source, 
or some combination of the two.

 

Module and Data Directories

 

Modules and data are stored in different directories. When your school installs the 
software, Win School creates one directory for modules, and another one for data. 
Each year’s data is stored in a separate data directory.

 

Single-User and Multi-User 

 

Your school will have purchased either the single-user or multi-user version of 
Win School. It’s important to know what version you are running because it tells 
you who has access to Win School data, and how many modules can be running 
simultaneously.

In the single-user version, Win School runs on one computer that stores both the 
Win School data and modules. Only one staff member can access modules and 
data at a time. Depending on the amount of computer memory, several modules 
can be running simultaneously.

 

School Setup State/Province
Details ASCII Transfer
Scheduler Scanning
Attendance Query
Report Cards Report Manager
Marks Utilities

 

*

 

Shell

 

*

 

Win School Server

Don’t confuse 
these directories. 1996 DATA 1997 DATA 1998 DATAMODULES

DATA

One staff member
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In the multi-user version, Win School is installed on several computers:

 

• the server computer

One computer, the server computer, stores data and distributes it to 
workstations.

• the workstation computers

Other computers, called workstations, run the Win School modules. One or 
more staff can access the Win School data at the same time from these 
workstations. 

Workstations can be located anywhere in the school, such as the main office, 
the principal’s or counselor’s offices, or at a teacher’s desk. 

 

How Modules and Data Relate

 

Completing tasks in Win School is much easier once staff know how modules and 
data work together.

 

This section describes three concepts:

 

• how the database is organized

• how the modules access this data

• how this interaction affects day-to-day operations

 

How Win School Data Is Organized

 

Win School database is a collection of all your school’s data, including student, 
teacher, and course data; scheduling data; attendance and student marks data. The 
figure below shows a simplified view of your Win School database. Data is 
organized in a hierarchy, one layer building on another: first school data; then 
course, teacher, and student data; followed by scheduling, marks, and attendance 
data. 

Modules, when calculating and performing other tasks, contribute data to and 
draw data from this database. One module builds on data previously entered by 
another module. 

Server computer Principal

Vice-Principal

Counselor

SecretaryClerk 

DATA
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For example, the Scheduler module that staff use to schedule students, uses 
school, course, teacher, and student data, when generating student schedules. 
Scheduler, in turn, contributes scheduling data to the database for modules that 
need this data to record attendance and calculate student marks.

 

Legend

 

 

 

How The Data Structure Affects Daily Tasks

 

• Data-entry time is reduced.

Shared data only needs to be entered once; this saves data-entry time and file 
space. For example, student names used for scheduling are not re-entered 
when recording attendance.

• Setting up follows a particular order.

When setting up for the first time, staff enter data in the order that reflects the 
database structure: first school data, then course data, and so on, as shown by 
the numbers 1 to 6 in the previous figure.

• Data is always up-do-date.

Modules contribute data to, and draw 
data from, the database.
Modules connect to one another 
through the Win School database.

Win School 
Database

2 course data

3 teacher data

4 student data

5 scheduling
data

6 attendance
data

6 marks data
1 school data

 

Item Description

 

1 to 6 the order data is entered into the database when first setting up
school data term dates, room types, course numbers, staff positions, attendance 

codes
course data course name, grade, department, maximum size, course semester 

length
teacher data teacher names, addresses, preferred courses and rooms
student data student names, addresses, contacts, programs, student number
scheduling classes, school and student schedules
attendance daily, twice-daily, and period attendance
marks student marks, earned credits, pass/fail status, class rank, GPAs
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• Staff can access data from different modules and in different ways, with 
these consequences:

 

As staff update data using different modules, the data displayed on your 
screen changes. Conversely, your changes affect the data seen by other staff.

 

Solutions to problems occurring in one module might originate in another 
module with which it shares data.

In multi-user version of Win School, not all modules can be open at the same 
time. 

 

What’s Next

 

The previous section describes your Win School database and how modules 
contribute data to and draw data from it. 

The remaining sections in this chapter describe each of the modules in detail, 
starting with two special software applications, the Win School Shell and Server. 

 

Special Win School Applications

 

This guide begins its tour of Win School software by describing two special 
applications that enable modules and data to interact: the Win School Shell and 
the Win School Server.

 

Shell 

 

The Shell is your doorway to Win School and its database. It is the first 
application to open when Win School is launched, and the last to close when you 
exit the software. 

 

The Shell serves several functions, including the following:

 

• It controls access to data and modules. All modules are launched from the 
Shell. Requests to view or change data are administered here. 

• It identifies your school. Embedded in the Shell are your school name, serial 
number, and authorization to use purchased modules. 

Modules

Staff

 course

teacher

student
scheduling

attendance

marks
school

Shell
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Server 

 

The Server is used for multi-user versions of Win School only. It enables more 
than one staff member to access school data at the same time from different 
computers. Staff using this version of the software start Win School from the 
Shell, the same as the single-user version.

 

Core Modules

 

Two modules, School Setup and Details, form the core of the Win School 
database. Information entered here is fundamental to how other modules operate. 

 

School Setup 

 

Using School Setup, staff enter information that tells Win School what your 
school looks like and how it operates. A great deal of diverse information, such 
as term dates, passwords, and attendance codes, is entered here. 

As its name implies, School Setup is the first module staff enter data into when 
setting up for the first time.

   
   Server

Counselor

Clerk

Secretary

Principal

course

teacher

student
scheduling

attendance

marks
school

Vice-Principal

course

teacher

student
scheduling

marks
school

attendance
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Details 

 

Details is a huge electronic file cabinet. Using it, staff enter detailed information 
about students, teachers, and courses. Staff enroll and withdraw students, and 
create and update teacher and course records. 

To do its work, Details uses school data entered in School Setup.

 

Modules for Scheduling, Recording Attendance, and Tracking 
Student Marks

 

Four modules—Scheduler, Attendance, Report Cards, and Report Cards’ 
companion, Marks—are the powerhouses of Win School. Using these modules, 
staff create school and student schedules, track attendance, generate term report 
cards and transcript information.

 

Scheduler 

 

Scheduler is a powerful module that builds and maintains both school schedules 
(who teaches what classes, at what time, and in which room) and student 
schedules, from course, teacher, student, and school data. 

Using Scheduler, staff can generate over 30 built-in scheduling reports on 
students, classes, teachers, and rooms.

student

teacher

course

scheduling

marks
school

attendance

scheduling
student

teacher

course

marks
school

attendance
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Attendance 

 

Attendance is an easy-to-use electronic attendance sheet where staff record or 
view daily and period attendance in a variety of formats. Using Attendance, staff 
can generate over 13 built-in reports on daily and monthly attendance statistics.

When tracking daily and period attendance, Attendance uses school, course, 
teacher, and student data. When tracking class attendance, Attendance also uses 
scheduling data.

 

Report Cards 

 

Report Cards is a module with a tremendous amount of flexibility. Its primary 
function is to consolidate current report card data and maintain data for past years.

In Report Cards, staff enter or import students’ marks and other data, such as 
teacher comments, work habit grades, and attendance totals. Report Cards 
calculates each student’s term marks, cumulative GPAs and earned credits, class 
rank, and honor roll. In addition, staff can generate a wide range of reports, 
including report cards and student transcripts.

To do its tasks, Report Cards draws on school, course, teacher, and student data. 
Report Cards uses classes created in Scheduler. Or, in schools that don’t use 
Scheduler, staff can schedule classes in Report Cards.

marks

scheduling
student

teacher

course

school

attendance

marks

scheduling
student

teacher

course

school

attendance



 

Win School Getting Started

The Big Picture • Modules for Viewing Only    15

 

Marks 

Marks is an electronic “gradebook” program for teachers that runs from 
workstations at teachers’ desks or some central location, such as the staff room. 

Teachers enter student scores. Then from school, course, teacher, student, and 
scheduling data, Marks calculates term marks, earned credits, and student and 
class averages for each class.

Marks can operate as a stand-alone product or with Win School. Marks with Win 
School connects to your school’s Win School database through the Report Cards 
module. 

Modules for Viewing Only

Query 

Query, one of the most frequently used modules, is a window into your database. 
Using Query, staff can quickly access student, teacher, and class information. For 
example, staff can find a parent’s phone number, locate a student in a class, or 
view attendance records.

Query is a view-only module. This means staff can view information and print 
reports, but they cannot enter, change, or delete any data.

marks

scheduling
student

teacher

course

school

attendance

marks

scheduling
student

teacher

course

school

attendance



Win School Getting Started

16    The Big Picture • Modules for Year-End Administration

Modules for Year-End Administration

Utilities

Utilities is a module that enables staff to process data for the next year. Utilities 
finalizes the current year’s data, and merges data from the current year’s database 
into next year’s database. 

Using Utilities, staff can generate trouble-shooting reports that pinpoint any 
problems in the year-end process.

Modules for Reporting Only

Many Win School modules can generate reports, in addition to their other 
functions. Built-in reports are ready-to-use reports that come with the software. 

Custom reports are school-designed reports. They are generated from templates 
that staff create in Report Manager. 

Report creation is the primary function of the following two modules:

• Report Manager

Staff create and run custom-designed reports. These reports can be shared 
between schools.

• State/Province

Staff run built-in reports whose specifications are defined by state or 
provincial departments of education.

marks

scheduling
student

teacher

course

school

DATA

NEXT YEAR’S 
DATA

attendance
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Report Manager 

Using this module, staff can create custom reports, form letters, and mailing 
labels, when built-in ones are not suitable or available.

Staff create a template, specifying the data and format required. Report Manager 
generates the report from Win School data according to the template 
specifications. Schools can build a library of templates.

State/Province 

Using this module, staff can run built-in reports whose requirements are defined 
by U.S. or Canadian departments of education. Only the reports purchased by 
your school are available in this module. Contact Chancery for a list of existing 
reports.

Staff select their report and report options. State/Province generates the report 
from Win School data according to the specifications.

reportsmarks

scheduling
student

teacher

course

school

attendance

reportsmarks

scheduling
student

teacher

course

school

attendance
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Modules for Transferring Data Only

Two modules—Scanning and ASCII Transfer—are data-entry time savers. Their 
sole function is to transfer data between Win School and other sources.

Scanning 

Using the Scanning module and optical scanners, staff can scan course requests, 
attendance, and term grades from commercial scanning forms (bubble forms) into 
the Win School database. 

Staff create and hand out the bubble forms to teachers or students who mark the 
forms and return them to staff. Using a scanner machine, staff scan the 
information marked on the forms. Then the Scanning module uploads the data 
from the scanner machine into the Win School database.

ASCII Transfer 

ASCII Transfer moves data between Win School and other applications running 
on micro-, mini-, or mainframe computers. ASCII Transfer, as its name implies, 
imports and exports data in any text-only (ASCII) format. 

bubble forms

course requests
daily class attendance
student marks

Scannermarks

scheduling
student

teacher

course

school

attendance

Other micro, mini, or 
mainframe computers

marks

scheduling
student

teacher

course

school

attendance
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Putting It All Together

The preceding sections describe individual Win School modules and how they 
connect to each other through the Win School database.The figure below takes 
this information and puts it all together into one picture.

What’s Next

This chapter has provided a conceptual view of how Win School works.

The next chapter walks you through the school year using Win School. It 
describes the tasks, the modules, and the staff involved at each step in the yearly 
cycle.

attendance

marks

scheduling

student

teacher

 course

school

reports

Micro, mini, or mainframe 
computersbubble forms

Scanner

Legend

direction of data flow
view-only access

contribution to database

NEXT 
YEAR’S 
DATA

Win School 
Database

Shell
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Using Win School over the School Year 

This chapter describes running Win School over one school year. 

We recommend schools take the yearly schedule described here and use it as a 
guide for developing their own. 

This schedule describes the tasks that need to be completed and the modules they 
can be done in. It also suggests which staff might be responsible for doing these 
tasks. You might not have the same staff available to complete these tasks. These 
suggested users are to help you determine who might perform these duties at your 
school, and to emphasize that one person cannot handle all the tasks involved in 
running Win School.

For simplicity, our sample schedule begins the school year in September and ends 
in June. There is a mid-term report card issued in November and February, and a 
final one in June. Schools can adapt this schedule to fit their own yearly cycle. For 
example, schools that run year round or have students attending different 
semesters need to adjust the schedule accordingly.

Before School Begins

August

Do these tasks Using these 
modules

Who does it?

enter or update setup 
info, such as school year, 
term dates, popup lists, 
passwords

School Setup Most often done by two staff: one 
who decides what data to enter; the 
other who actually enters the data. 
Could be a principal and a clerk, or 
a computing teacher and a secretary.

A great deal of information is 
entered the first time your school 
uses Win School. After this, only a 
few changes are required each year 
to keep the data up to date. Most of 
this data is the same from year to 
year.
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School Begins

September

enter or update courses, 
teachers, and students for 
current year

delete last year’s 
graduates and non-
returning students

Details

ASCII Transfer

Most often a secretary or clerk, or 
when importing data, the technical 
support person

A great deal of data is entered the 
first time your school uses Win 
School. Daily maintenance is 
required to keep student records up 
to date; yearly maintenance to keep 
teacher and course records updated.

schedule school and 
students

Scheduler

Report Cards

ASCII Transfer

Scanning

Most often done by two staff: one 
who decides what data to enter; the 
other who actually enters the data. 
Could be a principal and a clerk, or 
a computing teacher and a secretary.

The first schedule usually takes the 
longest to build. Many schools then 
copy and fine tune it from year to 
year.

create or update custom 
reports

Report Manager Most often done by main office 
support staff.

Do these tasks Using these 
modules

Who does it?

Do these tasks Using these 
modules

Who does it?

clean up enrollment 
discrepancies, including 
withdrawing and re-
entering students

Details Most often vice-principals, 
counselors, secretaries, and clerks

schedule new students 
and print timetables

Scheduler

Report Cards

Most often vice-principals, 
counselors, secretaries, and clerks
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Throughout the School Year

September to June

End of Semester

November and February

Do these tasks Using these 
modules

Who does it?

take attendance Attendance

Scanning

Most often secretaries, clerks, 
teachers

track student marks Report Cards

Marks

Scanning

ASCII Transfer

Most often secretaries, clerks, 
teachers, with the help of the 
technical support person

run reports Report Manager

Attendance

Scheduler

Report Cards

Details

Marks

State/Prov

Query

Utilities

All staff but most often principal, 
vice-principal, secretaries, and 
clerks

view information Query All staff

Do these tasks Using these 
modules

Who does it?

generate report cards Report Cards

Marks

Report Manager

Main office staff, counselors, 
teachers
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Mid-Year

February to March

End of School Year 

June

July

Do these tasks Using these 
modules

Who does it?

prepare for next year 
including

creating next year’s data 
directory and preparing 
next year’s data

Shell

Scheduler

Report Cards

School Setup

Details

Staff responsible for maintaining 
system. Could be principal, 
secretary, technical co-ordinator, or 
the technical support person

draft school and student 
schedules for next year

Scheduler

ASCII Transfer

Scanning

Do these tasks Using these 
modules

Who does it?

generate final report 
cards and update 
historical marks

Report Cards

Marks

Report Manager

Most often main office staff, 
counselors, teachers

Do these tasks Using these 
modules

Who does it?

run year end and 
graduate students

Utilities

Report Cards

Details

Staff responsible for maintaining 
system. Could be principal, secretary, 
technical co-ordinator, or technical 
support person
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Strategies for the First Year

Every school wants to have a successful installation and setup. 

This chapter describes three strategies that will help schools do this:

• phasing in Win School

• timing your implementation

• clarifying staff responsibilities

Phasing in Win School 

Because it takes time to learn new software, many schools make their 
implementations easier by phasing in modules rather than using them all at once. 

For example, schools can install School Setup, Details, and Attendance the first 
year; and then, after they are familiar with the system, add Scheduler in the second 
year. Or, install School Setup, Details, and Scheduler in the first months, and add 
Report Cards and Attendance later in the year. How schools phase in modules 
depends on which tasks are essential at the time of year Win School is installed. 

Also some schools opt to run parallel systems—both their old systems and Win 
School—for up to a year, using their old systems as backup. 

Timing a Successful Implementation 

Here are a couple of factors to consider when your school is figuring out how to 
get Win School up and running successfully:

• length of time to learn Win School

Learning times will vary depending on the computing experience of staff, 
how much training staff receive, and how often they use a particular module. 
Schools who schedule sufficient time to learn the software get the best 
results.

In addition, some tasks are done daily; others, such as next year prep, only 
once a year. To become completely familiar with Win School, staff need to 
work with modules over one complete school year.

• the optimal time to train staff 

The best time to train staff is just after Win School is installed and before 
setup has begun. After reading the Win School guides, staff can try their 
hands at some basic tasks such as entering School Setup data or enrolling 
students in Details. 

?

??
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Staff get the most out of training when they have a basic familiarity with Win 
School vocabulary and with the operation of the software, and when they 
have prepared questions about problems specific to their school’s system. 

• how long it takes to enter data in School Setup and Details

Schools enter a lot of data in these two modules when setting up for the first 
time. 

The following table lists estimated data-entry times for a school with 900 
students. These estimates assume that staff are ready to enter data—they are 
trained on the modules and know setup information such as student 
numbers, room numbers, and school semester dates. If staff are importing 
data, the files will need to be ready to import in ASCII format.

• how long it takes to build school and students’ schedules in Scheduler

Times vary depending on the complexity of your schedules and how course 
requirements are entered. Here’re some estimated times for a school with 
900 students:

Clarifying Staff Responsibilities 

Establishing staff responsibilities early on can lessen problems resulting from 
confusion over which staff are responsible for what duties.

In this guide, responsibilities are divided according to two user types: 

• the general user 

• the Administrator 

The term “Administrator” is one used frequently in Win School guides. For a 
detailed description of the Administrator’s duties, see the Win School 
System Administrator Guide.

Read the following table and identify who fits these roles in your school. Staff 
might be either general users or Administrators, or both general users and 
Administrators, depending on the size of your school, and the skills, interests, and 
current responsibilities of staff.

Module Estimated data-entry time

School Setup 1/2 day to 2 days
Details 1 to 2 days, depending on whether 

data is being imported as ASCII files 
or entered manually

Year Estimated time to 
schedule

1st year 1 to 2 weeks
2nd year 1 to 2 days
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User Types Duties Skills Who Fits this Role?

general users • responsible for a few 
tasks using one or 
two modules

• only need to know 
how to use “their” 
modules

• go to the 
Administrator for 
help

• know one or two 
specific tasks, such 
as enrolling students 
or recording 
attendance

• need a basic 
knowledge of the 
Windows 
environment

Depending on how responsibilities 
are divided in your school, a general 
user could be a secretary, clerk, 
teacher, counselor, principal, vice-
principal, and so on.

Administrator Responsible for running 
the entire Win School 
System, including:

• installing and setting 
up the software for 
general users

• troubleshooting 
problems 

• contacting Chancery 
Technical Support 
for help, if needed

• needs to know how 
entire school 
operates, not just 
one or two 
departments

• needs a solid 
understanding of 
Windows operating 
system and Win 
School SIS system

Depending on the size of your school 
and the complexity of its operating 
system, the Administrator could be 
several people.

Ideally, schools already have on staff 
a technology co-ordinator who is 
responsible for running the school or 
district network. Or one staff 
member, such as the principal, can 
team up with an offsite MIS person.

However schools often do not have 
this option. Schools then have the 
“techie person,” such as the 
computing science teacher or admin 
secretary with a computing 
background, fulfill this role. Schools 
that are most successful give their 
staff the time and training to learn 
their job.



Win School Getting Started

28    Strategies for the First Year • Clarifying Staff Responsibilities



Win School Getting Started

Reviewing Basics • What You Should Already Know    29

Reviewing Basics

Win School modules are easy to use because they are consistent in how they work 
and what they look like on your screen. 

Win School uses many standard Windows features, but it also has a few of its 
own. 

This section describes:

• what Windows features you should already know

• how to launch and quit Win School

• basic Win School operating features and conventions

What You Should Already Know 

You should have a basic understanding of your computer and be familiar with the 
Microsoft Windows environment. 

If you don’t know how to use Windows features, take the time to learn before you 
start Win School. Get a co-worker experienced with Windows to show you how 
to use it or refer to your Windows documentation.

General Checklist
Before you begin, check that you know how to do these tasks:

❑ Turn your computer on and off, using proper startup and shutdown 
procedures.

❑ Use a mouse.

❑ Work with scroll bars, windows, and dialog boxes.

❑ Work with stayup, popup, and pull-down menus.

❑ Enter and edit text.

❑ Minimize, maximize, resize, and close windows.

❑ Create, open, and save files.

❑ Select a printer and print setup options.

❑ Copy files to and from diskettes or over a network.

Administrator Checklist

If you are responsible for Administrator tasks, refer to the Win School 
Administrator guide for a checklist of what you should know before you begin. 
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Starting and Quitting Win School 

To start Win School, you first start the Shell and then your modules. The reverse 
procedure happens when you want to quit Win School: first you quit your 
modules and then the Shell. 

The Shell is always running when Win School modules are running.

Starting the Shell and Modules 
Before You Begin

❑ If you run the multi-user version of Win School, the Win School Server must 
be running and you must be logged onto the Server before you can start. 

For details on how to start and use the Server, see the Win School 
Administrator guide.

❑ Have your password and user ID ready.

If user IDs are not yet created, use “0”. 

If you are unsure of your password and ID, staff with proper access can 
check them in the Passwords dialog in School Setup. 

To start the Shell:

1 Double-click the CSL Win School icon from the Start menu.

2 A status dialog appears, showing the Shell’s progress reading your Win 
School data. Do nothing; simply wait for the Shell to complete its work.

3 In the Logon dialog that appears, type your user ID and password.

Win School icon
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4 Press Enter. 

The Shell appears. From here, you can start the Win School modules you 
have password access to.

 

To start modules: 

 

1 From the Shell, click the module you want to start. The module 
automatically opens.

Modules are dimmed if your password does not give you access to them.

After clicking a module, first the copyright screen appears briefly. Then a 
status dialog appears, showing the Shell’s progress retrieving data. Finally 
the module’s main window opens.

The User ID must be 
a number up to 7 
digits.

If User IDs are not yet 
created, type “0”.

The Password can 
be up to 7 numbers, 
letters, or spaces. 
Capitalization is 
important. “Amigo” is 
different from 
“amigo,” so 
remember which 
letters you capitalize.

Asterisks appear 
instead of the 
password to keep 
your password 
secret.Depending on how passwords 

are set up, you might only 
need to type your user ID. 

Here’s where 
your modules 
are displayed.

To start a module, 
click its icon.

Shell

Main window (Details)
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Quitting Modules and the Shell

 

To quit the Shell, you must first quit all modules.

 

To quit modules: 

 

1 Display the module’s main window. From the File menu, choose Quit.

The module closes and you are returned to the Shell. From here you can 
open another module, or quit the Shell.

 

To quit the Shell: 

 

1 Display the Shell. 

2 Close all modules.

3 From the Shell menu, choose Quit.

A status dialog appears, showing the Shell’s progress storing your data. 
When your data is stored, the Shell closes. You have now quit Win School.

 

Window Features at a Glance 

 

The figure below shows a typical Win School window—the Main window from 
the Details module. Most modules display some or all of these features.

Here’s the name of the 
module you are viewing.

The information icon is a button you 
click to display information about 
the window.

Here’s the menu bar.

The key icon is a button that you click to lock your screen.

View icons are buttons that 
you click to display different 
information in the bottom half 
of the window. 
For example, clicking the 
Students icon displays a list 
of students, as shown here.

This row is highlighted. To 
highlight a row, you click it.

Column headings are in bold type.

These thick borders mean 
you can change the width of 
the column.

VCR buttons conceal popup menus that allow columns 
to display different data.

Here’s the number of students selected  in the window.

Italicized students are 
inactive. Inactive students 
are not enrolled in school.
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Tips for Selecting Checkboxes

 

To assign items for printing or some other task, you need to select their checkboxes in the “Selected” 
column.

 

Displaying Information

 

 

 

This section describes basic Win School operating features and conventions.

 

Detail and List Windows 

 

In Win School, windows display information in two types of windows:

 

• List windows display lists, such as lists of students or schools. They do not 
show detailed information about each item in a list. Often, the main window 
of a module is a list window.

• Detail windows display data about one item. For example, the figure below 
shows a detail window displaying personal data for Blair Allsop. Not all 
detail windows look the same. You open detail windows from list windows. 

 

To select Do this

 

one box click it
all boxes shift-click
all boxes from the clicked 
box to the last item 

 

visible

 

 
in the window

control-click

all boxes from the clicked 
box to the last item in the 
window

shift-control-click

 

To deselect 

 

repeat the above 
commands
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Using VCR Buttons 

 

You can see more than one kind of data in a column that has VCR buttons.

 

 VCR buttons

Double-click... 

Detail Window

List Window

...to open.

 

To Do this

 

display different data in a 
column

Click the left or right VCR button.

cycle through all data options Click either VCR button several times; 
stop clicking when you see the data you 
want.

view all data options for a 
column

Click and hold a VCR button. A popup 
menu appears. listing your options.
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Changing Column Widths 

To better display data for viewing or printing, you can change the width of some 
columns. 

To change a column’s width, point the mouse arrow at the thick border line at the 
top of the column. The arrow turns into a hand. Click and drag left or right to 
move the column border.

Sorting Students 

In any window that lists students, you can sort the students in ascending or 
descending order by student name, student number, or grade. 

You can also create a sorting hierarchy. For example, you can sort students by 
grade, then by name within each grade. 

To sort students: 

1 From the Edit menu, choose Sort. The Students Sort Order dialog appears.

2 Choose your sort keys and arrange the sort order. 

3 From the Sort menu in the Students Sort Order dialog, choose Sort All. 

You are returned to the active window. Your students are listed in the order 
you determined.

Point your cursor at this line.

This side lists all 
items by which 
you can sort. 
These items are 
called sort keys.

This side lists the 
sort keys that are 
currently in use.

To Do this

select a key for sorting Click and drag it from the right to the left 
side. 

remove a key from sorting Click and drag it from the left to the right 
side.

sort in ascending order Click the arrow next to the sort key until it 
points up.

sort in descending order Click the arrow next to the sort key until it 
points down.

sort a key first Click and drag the key to the top of the list 
on the left side. The top key is sorted first.

clear all current sort keys From the Edit menu, choose Clear.
to revert to the previous sort order From the Edit menu, choose Revert.
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Keyboard Search Tip 

To search for an item in a list, you can do a keyboard search. For example, to 
search for a student in a list of students sorted by name, type the first letter of the 
student’s surname. The first student displaying these letters is highlighted. 

The first sort key is the criteria by which the keyboard search is performed. In 
other words, if you want to sort for a particular grade, make grade your first sort 
key; if by student number, make student numbers the first sort key.

Finding System and Module Information 

System information can be helpful when troubleshooting problems or setting up 
the system.

Manipulating Windows and Screens

The following Win School features make your software more convenient to use:

• locking and unlocking your screen

• minimizing the shell and modules

To find Do this from the Shell

information on these 
system files:

Autoexec Batch

Configuration

Win School Initialization

System Initialization

Windows Initialization

From the Shell menu, choose Technical Support. 
The Technical Support report is displayed to your 
screen. 

version number of modules From the Shell menu, choose View Info. The text 
icon appears, displaying the version number. To 
return to the graphic icon, choose View Info 
again.

 
Text 
icon

Graphic 
icon
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Locking and Unlocking Your Screen

You lock your screen to prevent anyone from looking at or changing your data 
while you are away from your computer. When you lock your screen, you don’t 
have to quit the module you are running and restart it.

Minimizing the Shell and Modules 

If you are running several modules simultaneously, you can reduce all the 
applications, except the one you are working in, to an icon.

Generating Win School Reports 

In Win School, you can generate three types of reports:

• built-in reports

Built-in reports are ready-to-use reports that come with—are “built-in” to— 
your software. Generally these reports are listed as options under the Reports 
menu in each module. 

For instructions on how to generate a report, refer to the guide for that 
module.

• custom reports

Custom reports are school-designed reports. They are generated from 
templates that staff create in Report Manager. 

To Do this

lock your screen In the title bar, click the key icon. A darkened 
screen appears. Your screen is now locked. No 
one can use your computer until you unlock it.

unlock your 
screen

To display the password dialog, click the 
darkened screen. In the dialog that appears, type 
your password and press Enter. Remember to use 
capitals if your password contains them. You are 
returned to the active window.

Key Icon

To Do this

minimize a module Open a module. From the File menu, 
choose Set Aside. The module is reduced 
to an icon.

make a module the active 
window

Click the module icon.

minimize the Shell Display the Shell. From the File menu, 
choose Minimize for Use. The shell is 
reduced to an icon.

make the Shell the active 
window

Open a module. From the File menu in a 
module, choose Win School Shell. 
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Templates define the form and content of the report. Report Manager 
generates the report from Win School data according to the template 
specifications.

• reports of selected items in the active window

In some modules, you can print a report of items selected in the window you 
are viewing.

This section begins by describing the Report Window and some basic operating 
features, such as printing the contents of the Report Window and setting report 
margins. The section ends by describing how to generate customs reports as well 
as reports of the active window. 

Report Window at a Glance 

When you generate a report in Win School, the report is automatically displayed 
to your screen. The window that displays your report is called the Report window. 

The following figure shows a typical Report window. Most Report windows 
display some or all of these features.

To display the previous 
page, click here.

To cancel a report, 
click here.

To change the size of the 
header or footer, click and drag 
the mouse on these bars.

This area is the body of the report. 
To move around the page, click 
and drag the mouse. The pointer 
changes to a hand, as shown here.

Report 
Header

The bar chart shows Win School’s 
progress generating the report.

Here’s the name of the 
report.

This is the page you 
are currently viewing. 
To go to another page, 
type the page number 
and press Enter.

To display the next 
page, click here.

Report 
Footer

2000
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Setting Page Margins for Reports 

From the Shell, you can set the page margins for your reports.

To set margins:

1 Display the Shell.

2 From the System menu, choose Margin Setup. Its dialog appears.

3 Select either inches or centimeters.

4 Type left, right, top, and bottom margins for your report.

5 Click OK.

All your reports are printed with these margins until you change the setting.

Selecting Report Options 

In Report Manager, staff create templates for custom reports. These templates are 
often too generic for what you want reported. For example, a template generates 
student names, numbers, and grades, and you want to print only female students 
in grade 10.

To be more selective in the data a custom template generates, you set report 
options for the template. You do this by selecting the “Use Report Options” 
checkbox in the Custom Template dialog when printing a custom template. This 
opens a selection of tab dialogs from which you can select the data you want 
printed.

Selecting Data Related to Student, Teachers, or Classes

The procedure for selecting student, teacher, or class data is same. For simplicity, 
the following instructions tell you how to select specific data for printing on 
student reports.

To Refer to

select data related to students, 
teachers, or classes

“Selecting Data Related to Student, Teachers, 
or Classes” on page 39

select report card bins “Selecting Report Card Bins” on page 41
select attendance dates and periods “Selecting Attendance Dates and Periods” on 

page 42
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To select report options:

1 From the Main window, select the items to be printed.

For example, if your report template prints student data, you need to select 
the students to be included in the report. The same applies to teachers and 
classes.

2 Open the Student tab dialog for the custom template you are using.

3 From the top popup menu, choose an option.

4 If you have selected all your options, click Print. If you need to select more 
options, using the VCR buttons, choose Filter from the popup menu if it is 
not already displayed. Then choose your options from the popup menus in 
the lower part of the dialog.

First choose an 
option from this 
popup menu.

To print Choose

all items in the Main window All
all highlighted items in the Main window Highlighted
all selected items in the Main window Selected
all students in the Main window who are 
selected and on the Honor Roll

Honor Roll

all students in the Main window who are 
selected and on the weighted Honor Roll

Honor (Weighted)

Using the VCR buttons, 
display this option.

Then select more options 
from these popup menus.
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5 If you chose Selected in previous step, you need to select more options. 
Otherwise, click Print. 

To select further options, using the VCR buttons, select a popup menu item.

6 Using the checkboxes, select the data you want included in the report.

7 Repeat steps 5 and 6 until all your options are selected.

8 Click Print.

Selecting Report Card Bins

To generate marks, you need to select the report card bins you want data generated 
from.

To select report card bins:

1 From the Main window, if necessary, select the items to be printed.

For example, if your report template prints student data, you need to select 
the students to be included in the report. The same applies to teachers and 
classes.

2 Open the Marks tab dialog for the custom template you are using.

To Select this option

not include the item in report Off
include only items with a value of Yes Yes
include only items with a value of No No
include only males Male
include only females Female
include only items with a value of All All
include only items with a value of N/A N/A
include only items selected in next step Selected
include the selected item other options

Using the VCR buttons, 
choose an popup menu item.

Then select the data you want 
included in the report.
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3 Select the bins you want printed.

4 Click Print.

Selecting Attendance Dates and Periods

When generating attendance reports, you can specify the dates and periods to be 
reported.

To select attendance dates and periods:

1 From the Main window, if necessary, select the items to be printed.

For example, if your report template prints student data, select the students 
to be included in the report. 

2 Open the Attendance tab dialog for the custom template you are using.

3 Type your attendance dates. Select your periods.

4 Click Print.

Select the report bins you want 
marks data generated from.

Type date range here.

To select a period, 
click here.
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Generating Custom Reports 

Custom reports are school-designed reports; they are not built into the software. 
Custom reports are generated from templates that staff create in Report Manager.

You can print custom reports from modules other than Report Manager. The 
following procedure tells you how to do this.

Before You Begin

❑ In Report Manager, check that the template exists, that it is up to date, and 
the module you want to generate the report from has been assigned access to 
this template.

To generate a custom report:

1 From the Main window, if necessary, select the items for the report.

For example, if your report template prints student data, you need to select 
the students to be included in the report. The same applies to teachers and 
classes.

2 From the Report menu, choose Custom Templates. 

3 In the “Template Name” column, highlight the appropriate template.

4 If you want to restrict the data the template generates, select the “Use Report 
Options” checkbox. 

For example, if the template generates student names, numbers, and grades, 
and you want to print only female students in grade 10, select this checkbox 
to open a set of Report Option dialogs from which you can restrict data. 

5 Click Print.

Depending on the options selected, you might need to complete more 
dialogs before your report is displayed to the Report window, or your report 
is displayed directly.

This column lists your 
available templates. Highlight 
the one you want use to 
generate your report.

To restrict the data the 
template generates, select 
this checkbox.
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Printing Reports 

When you generate a report, it automatically appears in the Report window on 
your screen. Follow these instructions to send your report to the printer.

Before You Begin

❑ Set the page margins of your report.

To print the Report window:

1 From the System menu, choose Print.

2 In the Printer dialog that appears, choose your options and click OK. 

3 Click OK.

The report is sent to the printer. 

Printing the Active Window 

In some modules, you can print a report of items selected in the window you are 
viewing. This is a simple, yet useful, procedure to know.

For example, in Attendance, you can highlight multiple students and print 
attendance information for those students. The same procedure applies in Details, 
except, instead of highlighting students, you select them. 

Generally, staff can print a report of information in any list window that displays 
select boxes.

To print selected items in the active window:

1 Select or highlight the items you want reported.

2 From the System menu, choose Print.

In the Print dialog appears, choose your options and click OK. 

3 Click OK.
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Setting Win School Preferences 

You can control how Win School operates by selecting options called 
preferences. When you set preferences, you are defining the following:

• How Win School makes its calculations and displays some data.

• The language and date range Win School operates in.

• The server Win School runs from.

Setting System, User, and Module Preferences

In Win School, there are three preference levels where you set date, display, and 
calculation preferences:

• System Preferences affect all Win School users and modules.

• User Preferences affect only the user who sets them and the modules she or 
he is running.

• Module-Specific Preferences affect only one module. 

How To Set Preferences

System and User preferences can be set in four modules: Details, Report Cards, 
Report Manager, and Scheduler. Module-specific preferences can only be set in 
the module they apply to.

For detailed instructions on how set preferences, refer to the online help for these 
modules. 

Who Can Set Preferences

Any staff member with more than view access to the previously mentioned 
modules can set preferences. Because of this, we recommend the system 
administrator be in charge of establishing guidelines for setting preferences in 
your school. Refer to the “Setting Up” chapter of the Win School System 
Administrator Guide for detailed instructions.

Selecting a Language 

To set the language Win School operates in, follow these steps. Some schools 
have two options: English or French.

To set the language:

1 Display the Shell.

2 From the Shell menu, choose Language.

3 In the dialog that appears, click the appropriate Language icon.

4 Click OK.
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Selecting a Server 

This feature is for schools running multi-user version of Win School who want to 
change to another Win School server. For example, larger schools occasionally 
store data from different years on separate servers.

To switch servers:

1 Display the Shell.

2 From the Shell menu, choose Set Preferred Server.

3 In the dialog that appears, highlight the server you want to access the next 
time you start Win School.

4 Click OK.

You are returned to the Shell. The next time you start Win School, you will 
start under the new server. You are connected to this server until you change 
your selection.

To have a dialog prompt you for the server each time you start Win School, from the 
Shell menu, choose Always Prompt for Server. A checkmark appears next to this 
option in the Shell menu. To deactivate this feature, simply choose the option again. 
The checkmark disappears. You are no longer prompted for a server.

Special Administrator Features 

The following table lists some special district-related tasks that the Administrator 
performs from the Shell. 

To Do this from the Shell

print the administrator’s 
log to the screen

From the Shell menu, choose Administrator’s Log. The 
log is printed to the screen. 

upload automatically to a 
district at a specified time

From the Shell menu, choose Auto-launch. A dialog 
appears that enables you to activate auto-launch.

view or delete uploading 
reports

From the Shell menu, choose either View Auto-launch 
Report or Delete Auto-launch Report.
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Using Query

Query is the one module from which you can view all your school data.
Without transferring to another module, you can view:

• student schedules, attendance, marks, and conduct

• student and teacher demographic data

• course and class data

You can also print reports of some active windows and generate reports from 
Report Manager templates.

Query is a view-only module. This means you can view data but you cannot add, 
change, or delete it.

Setting Up 

In Query, setup is straightforward.

If your school uses passwords, check you have the correct password access in 
School Setup.

The data you can view depends on:

• Your password access to other modules.

You can view data for all modules to which you have View, Change Only, or 
Edit access. If your access to a module is None, the icon for that module is 
dimmed.

• The modules your school has purchased.

If your school has not purchased a module, you cannot view its data; and the 
icon for that module is dimmed.

View-only works well for schools on a network. One staff member can view data 
while other staff are running other modules.

Using Query Windows 

Use 3 windows in Query to view data:

• the Main window

• the Student Detail window

• the Teacher Detail window
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Main Window 

When you start Query, the Main window is the first one to open. From the Main 
window, you can view a list of all students and teachers in your school, and open 
their detail windows.

You can use Menu options to look at:

• the student detail window for information about 1 student

• the teacher detail window for information about 1 teacher

You can display up to 5 windows at a time. This allows you to work with several 
student records at the same time, or to work with several records of 1 student.

Teacher Detail Window

The teacher detail window displays information about 1 teacher.

Student Detail Window 

The student detail window displays information about 1 student.

To display a list of 
students, click this 
icon.

To display a list of 
teachers, click this 
icon.

To open a detail 
window, double-click 
a name.

To display another 
view, click an icon. 
This window shows 
the Classes view.

This pointer tells you 
what class the 
teacher is currently 
in.
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Working with Several Windows

Query has several special features that allow you to move quickly between 
windows or display several windows at the same time, for example, when you 
want to monitor the progress of one student.

To display another 
view, click one of these 
icons. This window 
shows the Emergency 
view.

To Do this 

Open 1 detail window In the Main window, do one of the following:

• double-click a name

• highlight a name, then from the File menu, choose 
Open

• highlight a name, then press Enter
Work with several detail 
windows

In the Main window, from the Windows menu, choose 
Multiple Windows.

Open several detail 
windows at once

In the Main window, from the Windows menu, choose 
Multiple Windows. Next select the names you want to 
open. Then, from the File menu, choose Open Selected 
Items.

Close all selected detail 
windows simultaneously

In the Main window, from the File menu, choose Close 
Selected Items.

For this feature to work, Multiple Windows feature and 
the designated windows must be selected. 

Close all open detail 
windows

In the Main window, from the File menu, choose Close 
All Detail Windows.

Open the next detail 
window listed in the Main 
window

With 1 student’s detail window already open, make the 
Main window active. Then do one of the following:

• To go to the previous name, from the Query menu, 
choose Previous.

• To go to the next name, from the Query menu, 
choose Next.
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Viewing Data

In Query, you can view student, teacher, and class information. Before you begin, 
you need to verify the dates for which you are viewing information.

Using the Calendar

To look at student, teacher, and class information, first select:

• The date of the student classes, timetables, and rooms you want to view. The 
current date is the default date.

• For attendance totals, the date range.

Then select the type of data.

To set a viewing date for classes, timetables, and rooms:

1 Display the Main window.

2 From the Query menu, select Calendar.

3 In the dialog that appears, use the VCR buttons to set the year, month, and 
day you want to view.

4 Click OK. The dialog closes and you return to the Main window. The date 
range is set until you change it.

To set an attendance date range:

1 Display the Main window.

2 From the Edit menu, select Attendance Date Range. The Attendance Date 
Range dialog appears.

3 Use the VCR buttons to set the year, month, and day you want totals for. 
Click OK. The date range is set until you change it.

Calendar Codes

The days in the calendar may be of different types depending on the appearance 
of each day icon: 

Today Half day

Initialized day ADA day

Selected day Day outside of 
term

Normal day Holiday
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Viewing Student Information 

The following table gives a quick overview of where to find student information 
in Query. For more information about specific fields, use Query’s online help.

Viewing Details

In the Student Detail window, click the Details icon to display information from 
the student record in the Details module.

For more information, click the VCR buttons at the top of each column to select 
a type of information to display.

Personal Info displays student names, addresses, grade, homeroom, birthdate, and 
schools. This information is all entered on the Personal tab in Details.

Contact’s Info displays information for up to 6 contacts, depending on how many 
contacts are entered for the student in the Details module.

To find Look in

A list of all students in your school In the Main window, select the Student icon.
A Student record from the Details 
module including:

Personal information

Contact information

Groups and activities

In the student detail window, select Details. To 
display more information, use the VCR buttons. 

A student schedule of classes and 
rooms for a selected day

In the student detail window, select Classes. To 
display more information, use the VCR buttons. 
The hand pointer  tells you which class the 
student is currently in.

Daily and period attendance In the student detail window, select Attendance. 
To display more information, use the VCR 
buttons.

Student term and final marks In the student detail window, select Marks. To 
display more information, use the VCR buttons.

Contact information including:

Legal alert and contact 
information

Home and work phone numbers

Custody status

In the student detail window, select Contact.

Emergency information including:

Contacts

Home language

Doctor and medical information

In the student detail window, select Emergency.

Student picture In the student detail window, select Picture. To 
adjust the picture on your screen, use the VCR 
buttons.

Pictures must be loaded into the database from 
the Details module before you can view them.
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Miscellaneous Info displays programs, track, counselor, ethnic category, home 
language, lunch status, and user definable lists.

Transportation, Legal, and Health Info displays full medical information from the 
Health tab in Student Details, the Legal Alert, and the 6 Transportation fields.

Medical Comments displays information from the Health tab in Student Details.

Comments displays any comments entered for the student in the Personal tab in 
Details.

Activities displays any activities entered for the student on the Personal tab in 
Details.

Groups Info lists any groups entered for the student.

Status Info lists the student status codes.

Conduct Info lists the student conduct codes.

User Codes list the student user codes.

User Definable Fields displays all the user-definable fields.

User Definable Flags displays all the user-definable flags.

Viewing Classes

In the Student Detail window, click the Classes icon to display the schedule of 
classes and rooms for a student for the selected day. This icon will be dimmed if:

• there are no scheduled classes for that student on the selected viewing date

• the viewing date is outside the Scheduler term date range set in School Setup

• relative days have not been initialized

You may change the viewing date in the Calendar window to see the list of classes 
for a student.

Use the VCR buttons in the Classes window to display different columns.

Column Meaning

Time Time of day that a class is in session.

The  indicates in which class a student is scheduled or in 
which class a teacher is teaching. 

Period First time in your timetable that this class meets.
Available only if classes were scheduled in Scheduler.

Period Name Defined in the Period Labels dialog from the Scheduler menu in 
School Setup.
Available only if classes were scheduled in Scheduler.

Block Indicates the first block of the first time in your timetable that 
this class meets.
Available only if classes were scheduled in Scheduler.

Block Name Defined in the Block Labels dialog from the Scheduler menu in 
School Setup.
Available only if classes were scheduled in Scheduler.
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Viewing Attendance and Marks

Set the views for your query window by using the popup menus directly below 
the icons. Then use the VCR buttons to select the columns you prefer.

Attendance
(Long Code)
(Short Code)

Assigned to a student in the Attendance module. View long or 
short code as set in School Setup in the Attendance menu, 
Period Attendance codes.

Class Name Three possible elements:

Name: Course Name from Details.

Grade: Grade Level of the course.

Section: number identifying the section (class) of the course. 
Class Number Number of the class.
Class Alternate 
Name 

Alternate Name entered in Details for the course. Your school 
may use this field to store an abbreviated form of the class name 
or a name for internal use only.

Teacher Name Name of the teacher for this class.
Teacher Number The teacher number, not the employee number.
Room Number Room number where the class is taught.
Room Type Set up in the Rooms menu of School Setup.
Room Capacity Indicates the maximum number of students that a room will 

hold. Set in School Setup.
Room Phone 
Number 

The room phone number.

Room Title Room name different from the room type. Entered in School 
Setup.

Column Meaning

Column Meaning

Attendance

Present

Absent 
Excused

Absent 
Unexcused

Late Excused

Late 
Unexcused

Class attendance accounted by period. Account for presence, 
absence, and lateness according to either values or occurrences.

For example, Values can be Present = 0.5 and Absent = 0.5 for a 
student present for half a period and absent for half a period. 
Occurrences can be Present = 1.0 and Absent = 1.0 for a student 
present on Monday and absent on Monday.

Citizenship A letter grade reflecting the student conduct as a citizen of the class.
Class 
Alternate 
Name

The Alternate Name entered in Details for the course.

Your school may use this field to store an abbreviated form of the 
class name or a name for internal use only

Class Name Class Name has 3 possible elements:

Name: the Course Name from Details.

Grade: the Grade Level of the course.

Section: the number identifying the section (class) of the course.
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Class Terms The terms in which each class meets. Two sections of the same 
course can meet in different terms.

Comm. 1 -5 A student can have up to 5 comments in a bin for each class.
Earned 
Credits

Earned Credits reflect the student performance in the class, as well 
as the duration of the class. 

Usually the maximum number of credits a student can earn in a 
class is the number of Potential Credits. At some schools, students 
who pass the class earn the full number of potential credits, while 
students who fail the class earn no credits. At other schools, students 
can earn a range of credits, depending on their marks in the class.

Grade Points Grade Points reflect the student performance in class.
Is Final Mark Indicates whether the marks on that row counts towards the 

student’s final GPA, Earned Credit, and Potential Credit totals.
Is Honors Indicates the student is attempting honors work in the class. It does 

not reflect the student’s performance nor that the student is on the 
Honor Roll. 

Is Weighted Indicates that the marks on that row are to be weighted in weighted 
honor roll and class rank calculations.

Letter Grade The letter grade corresponding to the percentage.
Main 
Classroom

The main classroom for a class.

Name (Class) Class Name has 3 possible elements:

Name: the Course Name from Details.

Grade: the Grade Level of the course.

Section: the number identifying the section (class) of the course. 
P & C Table Points and credits tables describe how percentages correspond to 

letter grades, grade points, earned credits, and pass/fail status. This 
view lists the table that was used to calculate the marks.

Pass/Fail Current mark is a passing or failing mark for the class or the course.
Percent Use with Letter Grade & Comments, the percentage grade achieved 

by a student.
Potential 
Credits

Maximum credits for the class. A class with more student-teacher 
contact hours usually has more potential credits.

Print Flag To print the marks information for a specific class.
School The school in which the class is taught.
Teacher Name The teacher for this class.
Terms Terms in which each class meets. Two sections of the same course 

can meet in different terms.
Used in E. 
Credit

Indicates that the marks on that row are to be included in total 
Earned Credit calculations.

Used in GPA Indicates that the marks on that row are to be included in GPA and 
total Potential Credit calculations.

User Flags Your school decides whether it wants to use User Flags, and if so, 
what each is for.

Work Habit A letter grade reflecting the student study habits.

Column Meaning
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Viewing a Picture

To display a picture, load it in Details.

In Query, click the picture icon to view the student picture and use the VCR 
buttons to set the picture justification on the screen.

Viewing Teacher Information

The following table gives a quick overview of where to find teacher information 
in Query. For more information, use Query’s online help.

Generating Query Reports

In the Query module, you can generate the following reports:

• Free Teachers report

The Free Teachers report lists teachers who are scheduled as free for a 
specific day and period.

• Free Rooms report

The Free Rooms report lists rooms that are free on a specific day and period.

• Custom report

Use templates created in Report Manager.

To view Do this

A list of all teachers in your 
school

In the Main window, select Teacher.

Schedule of classes and rooms 
for a selected day for a specific 
teacher

In the teacher detail window, select Classes. To 
display more information, use the VCR buttons. 
The hand pointer  tells you which class the 
teacher is currently in.

Teacher record from Details, 
including:

Personal information

Address and home phone 
number

In the teacher detail window, select Details. To 
display more information, use the VCR buttons.

Homeroom information, 
including:

Phone number

Number and capacity

In the Main window, select Teacher. To display 
more information, use the VCR buttons
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Generating Reports on Free Teachers and Free Rooms

The procedure for generating these reports is the same.

To generate the report: 

1 Display the Main window.

2 From the Reports menu, select either the Free Teachers report or the Free 
Rooms report.

3 In the calendar at the top of the dialog, set the year, month, and day with the 
VCR buttons and by clicking on a day icon.

4 In the Selected column, select the period or periods.

5 Click OK to generate the report.

6 To send the report to the printer, choose Print from the System menu. Click 
the icon left of the window title.

Generating Custom Reports

If your school has developed its own reports, refer to the Report Manager Guide 
or online help for information.
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Main Glossary

This glossary defines terms specific to Win School. For terms describing your 
Windows operating system, refer to its guide.

Active Window The window you are viewing. If you have several windows open, 
the active window is the one on top.

Active/Inactive Status See Inactive.

Administrator A Win School user type. The staff person or people responsible for 
running the Win School system, including installing and setting up the software, 
and troubleshooting problems. See also General User.

Aide Type Staff enter aides types in Teacher Details and request aides for courses 
in Course Details. Scheduler uses this information to schedule aides into classes 
when building timetables. For detailed information, see the user guides or online 
help for Details and Scheduler.

Alphanumeric A combination of letters and numbers. For example, A101.

Application A software program. The Win School Shell, Server, and modules are 
applications.

ASCII Pronounced “ask-ee.” An acronym for American Standard Code for 
Information Interchange. ASCII is a language common to many software 
programs. Because many word processing programs can open an ASCII file and 
display its text, ASCII files are also called text files.

Backup A copy of your data you store on either a diskette or the server, in case 
the original data is damaged. Most schools back up their data at the end of each 
day. Because the computer’s hard disk can be damaged, a backup copy should not 
be stored on the same computer as the original data.

Bins Contain students’ term or mid-term marks for all their classes. In School 
Setup, you can define up to 30 Report Cards bins. For detailed information, see 
the user guides or online help for School Setup, Report Cards, and Marks.

Block The smallest unit of your schedule. For detailed information, see the user 
guides or online help for School Setup and Scheduler.

Block Timetable A schedule built on blocks rather than times. A block timetable 
describes the number of periods in a day and your school cycle. See also Cycle. 
For detailed information, see the user guide or online help for School Setup.

Built-In Report Ready-to-use reports that come with (are built into) your Win 
School software. Most often listed as menu options under the Report menu. See 
also Custom Reports.

Case-Sensitive Recognizing upper and lower case letters. In Win School, 
passwords are case sensitive. For example, “Imago” and “imago” are two 
different passwords.

Checkboxes Many features and options are turned on and off using checkboxes. 
This checkbox is selected . This one deselected .
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Choose Select from a menu. 

Class  A section of a course. Class names usually appear as the course name, 
grade, followed by the section number, in parentheses. For example, Math 6 (2). 
Classes are created in either Scheduler or Report Cards. 

Class Capacity Either the “Maximum Class Size” or the capacity of the room in 
which it is scheduled, whichever is smaller. For detailed information, see the user 
guide or online help for Details.

Class Roster A list of the students in a class. You create class rosters using 
Scheduler or Report Cards.

Click To press and quickly release the mouse button.

Cluster A group of students who are in the same program, grade, and required 
course section(s). For detailed information, see the user guide or online help for 
Scheduler.

Comment A prepared phrase you can select to describe a student’s behavior for 
reports and report cards.

Consolidation In Marks, the average of selected marks from one or more tasks 
that is stored as a new, separate task in any folder.

Constraint A restriction on the data to be printed in a report. Only those items 
meeting the report’s constraints are printed. 

Course See Class.

Custom Report School-designed reports that are generated from templates 
created in Report Manager.

Cycle A pattern of days that is repeated in your school schedule. See also Fixed 
Day and Relative Day cycles. For detailed information, see the user guide or 
online help for School Setup.

Data Factual information, such as student names or numbers, that staff enter using 
modules.

Database A collection of all your school’s data, including student, teacher, and 
course data; scheduling data; attendance and student marks data.

Default A value or setting that Win School automatically displays.

Delimiter A character that marks the end of a field or record.

Detail Window A window displaying detailed information about one item, such as 
a student, teacher, or class. See also List Window.

Directory A folder that stores Win School software or data. Your Win School 
module directory stores your modules; similarly, your Win School data is stored 
in a data directory. 

Double-click Two mouse clicks in quick succession. 

Elective A course that a student is not required to take to graduate. See also 
Required.

Exception Code Any period or daily attendance code that is not Present.

Export To transfer a copy of Win School data to an ASCII file, for use by other 
computers or applications.
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Field  A space in a window or dialog that contains data, or where you enter data. 
For example, a student’s last name is a field, as is the student’s number and 
gender. A field can contain numbers, letters, or alphanumeric characters. See also 
Flag.

Filters See Constraints.

Fixed Day Cycle  A schedule that lasts for 1 or 2 calendar weeks before repeating. 
On a one-week fixed cycle, every Monday is the same. If a holiday falls on a 
Monday, that day of the schedule is skipped, and on Tuesday, the schedule 
resumes with Tuesday classes. On a two-week fixed cycle, the same principles 
apply, except that your scheduling pattern runs for two weeks before it is repeated. 

Flag A special type of data field that can have only two possible settings. For 
example, “Yes” or “No.” See also Field.

Folder (1) In Marks, a folder holds a group of related tasks. You can create as 
many folders as you need for each class. (2) In Windows ‘95, another name for a 
directory.

Folder Calculation Method The method Marks uses to calculate students’ 
percentage scores in one particular folder. Possible methods are Total Points, 
Scalar Weight, and Percentage Weight.

Folder Percentage In Marks, the amount one folder contributes to the final mark. 
This can be a value out of 100%, or any number that indicates the folder’s weight 
relative to other folders.

Grading Scheme  A collection of information in a Points & Credits table, 
describing the numeric range of each letter grade as well as other course-related 
values established by the school.

Following Triplet Courses that are taught in consecutive periods in the same day.

General User A Win School user type. Staff responsible for performing tasks in 
one or two modules only, such as attendance clerks or counselors. See also 
Administrator.

Graduated Status of a student. You set a student’s graduated status manually in 
Report Cards. Any student who has graduated gets a status of “Graduate.” All 
other students are “Not Graduated.” In Details, graduated students appear with 
bullets (•) beside their names. 

Honors Status (1) A student’s status for a class. Honors status means a student is 
doing honors work in the class and is graded according to the Honors marks in the 
Points & Credits table. For detailed information, see the user guides and online 
help for Report Cards or Marks. (2) A setting that indicates whether a student has 
made the Honor Roll. If so, the student’s Honors Status displays as “Yes” in the 
main student window in Report Cards. For detailed information, see the user 
guide or online help for Report Cards.

IDs Stands for Identification Number. For example, course IDs, teacher IDs, and 
student IDs.

Inactive  (1) Inactive students are not enrolled in school. Inactive students appear 
in italics. (2) In a student’s list of classes, an inactive class is a class a student 
transferred out of before the class ended. The class is inactive for that student. 
Similarly, in a class’ list of students, any student who transferred out appears in 
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italics. That student is inactive in that class. For detailed information, see the user 
guide or online help for Report Cards.

Initialize In Attendance, double-clicking a day in the Calendar window to open the 
day. When you initalize a day, Win School assigns a value to the day to prepare 
it for your attendance information. If a day is not initialized, you cannot view or 
take that day’s attendance.

Italicized Names See Inactive.

Key Icon Enables you to lock your computer screen to prevent anyone from 
accessing your data when you leave your computer unattended. The Key icon is 
displayed in the Win School title bar.

Launch To start a Win School application, such as the Shell, or a module. 

Letter Grade A letter, such as A or B, that represents a student’s mark.

Linked Group Courses that are taught in the same period. They may be taught on 
different days, different terms, or simultaneously.

List Window A window displaying lists of items, such as students, teachers, or 
classes. See also Detail Window.

Localize To set spelling, terminology, and report options specific to your state or 
province. For detailed information, see the user guide or online help for School 
Setup.

Lock Icon Indicates you have view-only access or no access to data. Fields are 
locked if you don’t have password access to them, if they have been locked from 
School Setup, or if another user on your network already has edit access to them. 

Main Office In Marks, any staff at your school, such as secretaries or 
administrators, who are responsible for collecting teachers marks and generating 
student report cards. In most schools, these staff work out of the main office. For 
teachers using Marks with Win School, the main office generates report cards 
using Win School Report Cards.

Main Window Generally, the first window to appear when you launch a module. 

Mark The grade assigned to a student. A mark can be a letter grade, percentage, or 
special mark.

Marks Stand-alone When you run Marks Stand-alone, you do not connect to nor 
share data with any other Win School software.

Marks with Win School When you run Marks with Win School, you share data 
with Win School Report Cards either through a network or by copying data from 
diskettes. 

Modules Win School software programs. For example, School Setup and Details.

Multi-Tasking A process that allows a computer to perform two or more tasks at 
the same time. For example, it enables you to work on a spreadsheet while 
printing a report.

Multi-User Using the multi-user version of Win School, more than one person can 
access Win School data at the same time from different computers over a network.

Numeric Numbers only. For example, “456.” See also Alphanumeric.
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Occurrence Attendance totals can be calculated in terms of occurrences. A code 
with any non-zero present, late, or absent value counts as one present, late, or 
absent occurrence. For detailed information, see the user guide or online help for 
Attendance.

Off-Track Year-round schools run students and teachers on tracks. Students and 
teachers are off-track during the terms that they are on holidays. See also On-
Track.

Online Help Help available on-screen when you are running Win School. 

On-Track Year-round schools run students and teachers on tracks. Students and 
teachers are on-track when they attend school. See also Off-Track.

P&C Stands for Points & Credits. See Points and Credits.

Percentage In Marks, a number out of 100 that represents a student’s mark for a 
task or group of tasks.

Percentage Weight In Marks, a number between 1 and 100 that defines the 
percent of the folder total that each task is worth.

Points and Credits Points and Credits tables define your school’s regular and 
honors grading scheme. Win School uses these tables to correlate percentages, 
letter grades, grade points, earned credits, and the pass/fail status.

Press You press keys on the keyboard. You click buttons on the mouse.

Record All information in a database about one item, such as a student or teacher.

Register Built-in attendance reports that contain student names, dates, and 
attendance codes.

Relative Day  A rotating schedule that can have up to 18 days. If every day has the 
same classes scheduled in the same order, you have a 1-day cycle. For detailed 
information, see the user guide or online help for School Setup.

Report See Custom Report and Built-in Report.

Request List A list of requested programs for students. You create this list in 
Details. 

Required A course that a student must take to graduate. Any course that is not 
required is an Elective. 

Restore To copy data to your hard drive from a backup. 

Resource Mapping A technique for scheduling classes that meet in the same room 
at the same time with separate teachers, or that meet in different rooms at the same 
time with the same teacher.

Rotating Cycle See Relative Day Cycle.

Scalar Weight In Marks, a number that defines a task’s relative value to the 
folder’s total.

School Timetable Your school schedule. It describes who teaches what classes, at 
what time, and in which room. See also Student Timetable.

Secret Names Letters and/or numbers assigned to a student to provide anonymity 
when posting student marks.
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Select To choose an item, such as a checkbox, field, or icon, in a window or 
dialog.

Server A computer that provides services for staff on a network. 

Single-user The single-user version of Win School enables only one staff at a 
time to access a data directory. If your school has a network, different staff can 
use Win School, but they can’t access the same data directory simultaneously. See 
Multi-User.

Smart Pronoun Codes that you use instead of names and pronouns when entering 
comments. When comments are printed, these codes are replaced with the 
student’s name or gender-specific pronoun. For example, the code “^d” prints as 
“son” or “daughter.”

Special Mark In Marks, a word, such as “Omit” or “Cheated”, that you can enter 
in place of a mark to indicate why a student received no mark. The word entered 
determines whether the student gets zero for a task, or the task is omitted from the 
student’s averages.

Stand-Alone A stand-alone computer is not connected to any other computers 
through a network.

Statistics Built-in attendance reports that contain attendance totals, without 
student names, for a specified date.

Student Cluster A student cluster is a group of students in the same program and 
grade who take the same section or sections of required courses. 

Student Timetable A student schedule. It describes which classes a student is 
taking, at what time, in which room, and with which teacher. See also School 
Timetable.

Summary Built-in attendance reports that contain student names and attendance 
totals for a specified date.

System Administrator See Administrator.

System menu A standard Windows menu located at the top left corner of each 
window’s title bar. This menu offers useful options such as Close and Print.

Tab Dialogs Detail windows that look like file folders with tabs at the top. For 
example, in Details, a student’s personal information is organized on one tab and 
conduct information is organized on another. 

Task In Marks, an assignment or activity for which each student receives a mark. 
You can create as many tasks as you need within each folder. A task is defined by 
its maximum score and its value relative to other tasks.

Teacher File In Marks, the data file that stores all your information, including 
your classes, class rosters, student scores, and report card marks.

Technical Support Chancery’s telephone support.

Term  In School Setup, you define Scheduler terms and Attendance terms.

A Scheduler term is the length of the shortest class taught at your school. 
Attendance terms are date ranges for attendance totals. These dates may be the 
same as the Scheduler term dates, or, if you report attendance twice in each term, 
they may be half of a Scheduler term.



Win School Getting Started

Main Glossary  •  63

Template A file that defines the content and look of a report. 

Text File See ASCII.

Timetable A school or student schedule. See School Timetable and Student 
Timetable.

Title Bar The horizontal bar at the top of a window that shows the name of the 
window. 

Total Points In Marks, a flag which indicates whether the task is counted in the 
folder calculations. “Yes” means the tasks is counted; a “No” means it is not.

Track Schools that meet year-round place students and teachers on tracks. Each 
track meets for different terms of the year. In any term, one or more tracks may 
be on vacation. 

Update Notes  Information on new features, fixes, and changes about a new 
version of Win School. Update notes accompany the Win School diskettes when 
the new version is shipped to you.

User ID A sequence of numbers and characters you must type to gain access to 
Win School. 

Value In School Setup, each daily and period code is assigned Present, Absent, 
and Late values, usually between 0.000 and 1.000. Attendance can be totalled by 
adding these values. See also Occurrences.

VCR Button A button with two arrows that usually appears at the top of a column. 
Click this button to change the data displayed in the column.

Volume A general term referring to a storage device or to part of a storage medium 
formatted to contain files. A volume can be an entire disk or only part of a disk. 

Weight In Marks, a value that indicates a folder’s or task’s importance relative to 
other folders or tasks. A task’s weight shows how much the task contributes to the 
folder total. A folder’s weight shows how much the folder contributes to the 
student’s final mark for that class.

Win School Chancery Software’s student administration system for the Windows 
environment. 

Year-Round Schools that are open all year round. They place their students and 
teachers on tracks. Each track meets for different terms of the year. In any term, 
one or more tracks may be on vacation. 
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 Index

A
about Chancery Software 5
Administrator, described 26
Always Prompt for Server menu option 46
ASCII Transfer module 18
Attendance module 14

B
basics, reviewing 29
built-in reports 37

C
Chancery Software, about 5
changing column widths 35
Clear menu option 35
Close All Detail Windows menu option 49
Close Selected Items menu option 49
columns, changing widths 35
custom reports 37, 43
Custom Template menu option 43

D
data

defined 7
directory for 7
restricting report data 43

Delete Auto-launch Report menu option 46
detail windows

described 33
in Query 48

Details module 13
displaying data

changing column widths 35
detail windows 33
list windows 33
locking/unlocking screen 37
module version number 36
Report window 38

sorting students 35
system info 36
VCR buttons 34
view icons 32

E
Edit menu

Clear option 35
Revert option 35
Sort option 35

entering passwords and IDs 30
estimating setup times 25

F
File menu

Close All Detail Windows option 49
Close Selected Items option 49
Minimizing for Use option 37
Open Selected Items option 49
Quit option 32
Set Aside option 37

filters, selecting for reports 39
Free Rooms

menu option 56
report 56

Free Teachers
menu option 56
report 56

G
general user, defined 26
generating reports

See Reports.
getting started

basics 29
checklist 29
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H
hand pointer, in Query 51, 55
help

Chancery’s Technical Support 5
online help 3
other Win School guides 4
system info 36
update notes 4

I
icons

in Query 48, 51, 55
in windows 32
key icon 32, 37
view icons 32

implementing Win School
learning software 25
strategies 21, 25
timing 25
training 25

installing Win School 4
italicized items 32

K
key icon 32, 37
keyboard search 36

L
Language menu option 45
launching

See Starting.
list windows, described 33
listing students 35
locking your screen 37
logging on 30
Logon dialog 30

M
Main window

features of 32
in Query 47, 48
printing 44

Margin Setup menu option 39
margins, setting for page 39
Marks module 15
minimizing

modules 37
Shell 37

Minimizing for Use menu option 37
modules

defined 7
directory for 7
minimizing 37
quitting 32
setting preferences for 45
starting 31
startup strategies 25
version number 36

modules, list of
ASCII Transfer 18
Attendance 14
Details 13
Marks 15
Query 15
Report Cards 14
Report Manager 17
Scanning 18
Scheduler 13
School Setup 12
Server application 12
Shell application 11
State/Province 17
Utilities 15

Multiple Windows menu option 49
multi-user system 8

N
Next menu option 49

O
online help 3
Open Selected Items menu option 49
opening

detail windows 33
list windows 33
modules 30, 37
Shell 30, 37
VCR buttons 34
Win School 30

P
page margins, setting 39
passwords, entering 30
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preferences 45
Previous menu option 49
printing

active window 44
reports 44
selecting items 32

Q
Query menu

Next option 49
Previous option 49

Query module
described 15
icons 48
setting up 47
windows 47

Quit menu option
for modules 32
for Shell 32

quitting
modules 32
Shell 32
Win School 30

R
release notes 4
Report Cards module 14
Report Manager module 17
Report window

features 38
printing 38
setting page margins 38

reports 37
built-in 37
custom 37, 43
Free Rooms report 56
Free Teachers report 56
generating 37
of the active window 37
printing 44
report-generating modules 16
restricting data in 39, 43
using Query 56

Reports menu
Custom Templates option 43
Free Rooms option 56
Free Teachers option 56

Revert menu option 35

roles
See Users.

running reports
See Reports.

S
Scanning module 18
Scheduler module 13
scheduling, yearly tasks 21
School Setup module 12
screen conventions

See Window Conventions.
searching for items 35
selecting

a server 46
filters for reports 39
items in a window 32
report options 39

server computer, defined 9
Server, Win School

described 12
selecting 46

Set Aside menu option 37
setting page margins 44
setting preferences 45
setting up

for Query 47
See also Implementing Win School.

Shell
described 11
minimizing 37
picture of 31
quitting 32
starting 31

Shell menu
Always Prompt for Server option 46
Delete Auto-launch Report option 46
Language option 45
Quit option 32
Set Preferred Server option 46
Technical Support option 36
View Auto-launch Report option 46
View Info option 36

signing on 30
single-user system 8
sizing

columns 35
minimizing Shell or modules 37
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Report window 38
windows 37

Sort All menu option 35
Sort menu

Sort All option 35
Sort menu option 35
sorting students 35
staff roles

See Users. 26
starting

modules 30, 31
Shell 30
Win School 21, 30

State/Province module 17
Students Sort Order dialog 35
students, sorting 35
support from Chancery 5
switching servers 46
System menu, Margin Setup option 39
system preferences 45

T
technical support

contacting 5
defined 62

Technical Support menu option 36
templates 37
training, estimating setup times 25
types 37

U
unlocking your screen 37
update notes 4, 63
Use Report Options checkbox 39
user IDs, entering 30
user preferences 45
users

Administrator 26
general user 26
multi-user 8
responsibilities of 21, 26
single-user 8
types of 26
who this guide is for 1

Utilities module 15

V
VCR buttons 34
version numbers, modules 36
View Auto-launch Report menu option 46
view icons 32
View Info menu option 36
viewing data

See also Displaying Data.
using Query 50

W
Win School

defined 7, 63
how it works 19
other manuals 2, 4
quitting 30
setting preferences 45
starting 30
startup strategies 25
system info 36
upgrades 4
version numbers 4

window conventions
changing column widths 35
highlighted items 32
icons 32
information icon 32
italicized names 32
key icon 32
popup menus 32
select boxes 32
VCR buttons 32

windows
features of Main window 32
features of Report window 38
in Query 47

Windows menu
Multiple Windows option 49

workstations, defined 9

Y
year end 15, 24
yearly cycle 21


